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1 ТЕОРЕТИЧЕСКАЯ ЧАСТЬ 

 1.1 Введение в термоакустику 

 Термоакустика это наука изучающая взаимное преобразование 

акустической и тепловой энергии. В основе этой науки лежит принцип 

сформулированный Лордом Рэлеем в 1857 году в [1], где он дал первый 

качественный анализ акустических колебания вызванных теплом:«Если 

теплота сообщается газу в момент наибольшего сжатия или отнимается от 

него в момент наибольшего разрежения, то это усиливает акустические 

колебания». Не смотря на простоту формулировки данного принципа,  для 

описания рабочих процессов термоакустических установок используется 

сложный комплекс теплофизических процессов, основанный на 

взаимодействии явлений акустической, теплофизической и 

гидродинамической природы. Эта многофакторность обуславливает 

особенности термоакустических машин и, в конечном итоге, их внешние 

характеристики. 

 Термоакустический двигатель - это установка, в которой за счет 

подвода тепла (внешнего или внутреннего) возникают акустические 

колебания. Термоакустические преобразователи набирают большой интерес 

у множества исследовательских центров в последние 20-30 лет. 

Преимущество установок работающих на основе термоакустического 

принципа заключается в совершении механической работы за счет 

возмущений акустического поля, при этом в преобразователе энергии 

отсутствую какие-либо подвижные части, что значительно повышает ресурс 

эксплуатации установки, относительно современных аналогов работающих 

на других принципах. Основные рабочие процессы в термоакустическом 

двигателе описываются с применением одновременно как теории акустики 

так и термодинамики.  
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 1.2 Акустические процессы 

 Работа термоакустического преобразователя связана с наличием 

акустических колебаний. Предположим, что продольная, плоская, 

гармоническая волна распространяется вдоль оси x резонатора, который 

заполнен идеальным газом. Акустические колебания зададим с помощью 

уравнения, описывающего стоячую волну: 

𝑝(𝑥, 𝑡) = 𝑝𝑠cos𝑘𝑥sin𝜔𝑡 = 𝑝𝑠cos(𝜔𝑡 − 𝑘𝑥),  (1.1) 

где 𝑝𝑠 - амплитуда избыточногодавления звуковой волны; 

𝑘 =
𝜔

𝑎
 - волновое число;  

𝜔 = 2𝜋𝑓 - угловая частота колебаний;  

𝑎- скорость распространения звуковой волны.  

 Распространение звуковой волны происходит благодаря 

колебательным движениям элементарных газовых объемов - частиц. 

Скорость их движения можно определить, воспользовавшись вторым 

законом Ньютона, который применительно к акустическим процессам можно 

записать в виде: 

𝜌
∂𝑢

∂𝑡
= −

∂𝑝

∂𝑥
,         (1.2) 

 После подстановки (1.1) в (1.2) и интегрирования, получим: 

𝑢(𝑥, 𝑡) =
𝑝𝑠

𝜌0𝑎
sin𝑘𝑥cos𝜔𝑡 =

𝑝𝑠

𝜌0𝑎
sin(𝜔𝑡 − 𝑘𝑥),  (1.3) 

где 𝜌0- средняя плотность рабочего газа. 

 Распространение акустической волны, согласно Лапласу, является 

адиабатическим процессом. С учетом этого скорость распространения звука 

определяется как: 

𝑎 = √𝛾
𝑝0

𝜌0
,     (1.4) 

 Амплитуда скорости колебаний частиц газа: 
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𝑢𝑠 =
𝑝𝑠
𝜌0𝑎

,     (1.5) 

 Величину смещения частиц газа вдоль оси х можно определить как: 

𝜉 = ∫𝑢𝑑𝑡 = −
𝑢𝑠

𝜔
cos(𝜔𝑡 − 𝑘𝑥) = 𝜉𝑠sin(𝜔𝑡 − 𝑘𝑥 − 𝜋/2),  (1.6) 

где 𝜉𝑠 =
𝑝𝑠
𝜔𝜌𝑎

 - амплитудное значение смещения частиц газа. 

 Пульсации давления вызывают локальные изменения температуры 

газа. Воспользовавшись уравнениями состояния идеального газа: 

 𝑝𝑉 = 𝑅𝑇 = 𝑝/𝜌     (1.7) 

 Представим уравнение (1.7) в виде адиабаты Пуассона: 

𝑝𝑠 = 𝑝0 (
𝜌𝑠
𝜌0
)
𝛾
,     (1.8) 

 После преобразования уравнения (1.8) получим: 

𝑇𝑠 = 𝑇0 (
𝑝0+𝑝𝑠
𝑝0

)

𝛾−1
𝛾

,      (1.9) 

 Как показано в работе [2], выражение для разницы температур, 

вызванной пульсациями давления в звуковой волне, можно получить в 

упрощенном виде: 

𝛥𝑇𝑠 ≅
(𝛾−1)

𝛾

𝑝𝑠

𝑝0
𝑇,     (1.10) 

 Рассмотрим волновые процессы в закрытой и открытой трубках, 

представленные рисунке 1.1. Если в закрытой трубе имеет место стоячая 

акустическая волна, тогда на торцах трубы образуются узлы колебательной 

скорости, а в центрах - пучность. 

 Для функции давления ситуация обратная, так как фазы колебаний 

давления и скорости отличаются на величину 𝛥ϕ ≤ 𝜋/2. Поэтому в 

центральной части канала, вдали от стенок, частицы газа имеют 

максимальное смещение 𝜉𝑠maxпри неизмененной температуре. В торцах 

канала перемещения частиц отсутствуют, а изменения температуры 

максимальны. На удалении от узлов давления и скорости, частицы газа 
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совершают колебательные движения 𝜉(x), их температура изменяется в 

зависимости от положения оси канала. 

 В открытой трубе, представленной на рисунке 1.1 б, формируется 

бегущая волна, в которой значения функции скорости и давления 

изменяются синхронно. Такие колебания вызывают циклические и 

однонаправленные изменения температуры частиц среды. 

 1.3 Термодинамические процессы 

 Работа термоакустических преобразователей основана на 

взаимодействии температурных полей, вызванных звуковыми волнами, с 

границами каналов - теплообменными поверхностями. Предположим, что 

изучаемые микрообъемы газа расположены вблизи стенки представленной на 

рисунке 1.2, которая имеет продольный градиент температур ∇𝑇𝑚. 

 

    а - стоячая волна 

    б - бегущая волна 

    в - диаграммаT=f(x) для частиц стоячей волны 

    г - диаграмма T=f(x) для бегущей волны 

    д - случай наложения стоячей и бегущей волн 

Рисунок 1.1 - Изменение температуры частиц газа в акустической волне вдоль оси канала 

за один цикл 
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 Если градиент температуры вдоль стенки канала меньше, чем градиент 

температур ∇𝑇, который возникает в элементарном объеме газа при его 

смещении, как показано на рисунке 1.2 а, то газ будет отбирать тепло от 

стенки при минимальном давлении и отдавать его стенке в зоне с 

максимальным давлением. Для создания такого механизма необходимо 

совершать работу - поддерживать колебательный процесс. При таких 

условиях частица газа работает как термоакустический холодильник или 

тепловой насос. 

 В случае, когда продольный градиент температуры превышает 

градиент температуры, развиваемый элементарной газовой тепловой 

машиной, тепло от стенки будет передано газу в зоне с большим давлением и 

отведено от осциллирующего объема в области пониженного давления. В 

результате амплитуда давления будет возрастать, соответственно будет расти 

энергия акустического поля. Таким образом будет реализован 

термоакустический тепловой двигатель. 

 

    a - малый температурный градиент 

    б - большой температурный градиент 

Рисунок 1.2 - Диаграммы T=f(x) 

 Рассмотрим подробнее основные термодинамические процессы, 

протекающие в термоакустических тепловых машинах. В данном случае мы 

не будем учитывать влияние вязкости среды на характер ее движения. 
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 На рисунке 1.3 показана принципиальная схема простейшего 

термоакустического преобразователя. Это полуволновой резонатор, внутри 

которого расположены теплообменные поверхности - рекуперативные 

теплообменники и регенератор (стек). Считаем, что стек - это система 

плоскощелевых каналов, длиной 𝐿𝑠, зазор между пластинами равен 2𝛿𝑘, 

продольный градиент температур в регенераторе : 

∇𝑇𝑚 = 𝛥𝑇𝑚/𝐿𝑠 = (𝑇𝐻 − 𝑇𝐶)/𝐿𝑠.    (1.11) 

 Это означает, что при смещении вдоль оси x на расстояние 𝜉 = 2𝑥1 

температура стенки изменится на величину 2𝑥1∇𝑇𝑚. Термодинамический 

цикл, совершаемый элементарной частицей газа под действием акустической 

волны, в принятой постановке , схож с циклом Брайтона, реализуемым в 

газотурбинных двигателях, который состоит из четырех последовательных 

процессов, представленных на рисунке 1.4, а именно: двух адиабатических 

этапов сжатия и расширения, и двух изобарных процессов, 

сопровождающихся теплообменном между газом и стенками стека. 

 

Рисунок 1.3 - Схема термоакустического преобразователя и его функции p,u=f(x) 

 

 Рассмотрим каждый процесс отдельно: 

 1. Адиабатическое сжатие-расширение (шаги 1 и 3). В начале процесса 

объем элементарной частицы газа равен V, давление 𝑃𝑚−𝑃1, температура 
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𝑇𝑚−𝑥1∇𝑇𝑚. Акустическая волна вызывает смещение частицы газа на 

расстояние 𝜉 = 2𝑥1, при этом микрообъем газа сжимается до V-V1, а его 

температура увеличивается на величину 2T1. 

 В адиабатных процессах параметры давления и температуры связаны 

между собой термодинамическими соотношениями: 

𝑇𝑑𝑆 = 𝑐𝑝dT +
𝑇

𝜌2
(
∂𝜌

∂𝑇
) dp = 0,   (1.12) 

 Используя (1.12) можно получить: 

𝑇1 = (
𝑇𝛽
𝜌𝑐𝑝

)𝑝1.    (1.13) 

 

 

Рисунок 1.4 - Последовательные этапы и термодинамические параметры частицы 

 

 Учитывая, что для изобарного процесса в идеальном газе 𝑇𝑚𝛽 = 1 и 

коэффициент термического расширения определяется выражением: 

𝛽 = −
1

𝑉
(
∂𝑉

∂𝑇
)
𝑝
,    (1.14) 

 Можно получить выражение, аналогичное (1.10): 
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𝑇1 =
𝛾−1
𝛾

𝑝1
𝑝𝑚
𝑇𝑚,    (1.15) 

 Индекс m показывает, что рассматриваются усредненные параметры 

элементарного газового объема - частицы. После ее смещения на расстояние 

𝜉 = 2𝑥1 термодинамические параметры изменятся, температура частицы 

станет равна 𝑇𝑚−𝑥1∇𝑇𝑚+2𝑇1, давление 𝑃𝑚+𝑃1, объем V-V1. 

 На этапе расширения частицы газа возвращаются в свое 

первоначальное положение, перемещаясь на расстояние 𝜉 = 2𝑥1. В этой 

точке термодинамические параметры частицы газа принимают следующие 

значения: давление 𝑃𝑚−𝑃1, температура 𝑇𝑚+𝑥1∇𝑇𝑚−2𝑇1 и объем 𝑉 − 𝛿𝑉. 

Теперь температура и объем частицы газа иные, чем в первоначальный 

момент, так как внутренняя энергия микрообъема газа изменилась на 

величину переданного стенке количества тепла 𝛿𝑄1. 

 2. Изобарный теплообмен (шаги 2 и 4). В начальной x и конечной x+2x1 

точках скорость частиц газа близка к нулю. При этом разница температур 

газовой частицы и поверхности стека достигает величины: 

𝛿𝑇2,4 = 2𝑇1 − 2𝑥1∇𝑇𝑚,    (1.16) 

 Если 𝛿𝑇 ≠ 0, то имеем условия для обмена теплотой между газом и 

элементом стека, в котором будет передано количество тепла 𝛿𝑄1 и 𝛿𝑄2. 

Если масса газа в рассматриваемом микрообъеме m, тогда количество 

переданной теплоты равно: 

𝛿𝑄3,4 ≈ 𝑚𝑐𝑝𝛿𝑇3,4,    (1.17) 

 Таким образом, последовательные шаги 1-2-3-4 образуют 

термодинамический цикл, изображенный на рисунке 1.5. 

 Работа, совершенная элементарной частицей газа, в данном 

термодинамическом цикле равна: 

𝛿𝑊 = ∫ 𝑝𝑑𝑉
𝐴𝐵𝐶𝐷

≈ −2𝑝1𝛿𝑉,    (1.18) 



12 
 

 Учитывая взаимосвязь 𝛿𝑇и 𝛿𝑉, через формулу для коэффициента 

термического расширения (1.14), получим: 

𝛿𝑉 = (𝛽𝑉)𝑚𝛿𝑇,       (1.19) 

 Подставив (1.19) в (1.18), работу элементарного термодинамического 

цикла можно переписать в виде: 

𝛿𝑊 ≈ −2𝑝1(𝛽𝑉)𝑚𝛿𝑇,    (1.20) 

 Из формулы (1.20) видно, что направление процессов переноса теплоты 

определяет знак величины 𝛿𝑇. Если 𝛿𝑇<0, то тепло от стека передается 

частице газа и реализуется термоакустический двигатель, если же 𝛿𝑇>0, то 

газ передает стенке стека тепло, что характерно для термоакустического 

холодильника. 

 

 

Рисунок 1.5 - P-V диаграмма идеального термоакустического цикла 

 

  Если изменение температуры в адиабатическом процессе 

расширения(сжатия) совпадает с изменением температуры стенки стека по 

длине,𝛿𝑇 = 2𝑇1 − 2𝑥1∇𝑇𝑚 = 0, то градиент температур называется 

критическим: 
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∇𝑇𝑐𝑟𝑖𝑡 =
𝑇1

𝑥1
,     (1.21) 

 Учитывая (1.13) и зная, что 𝑥1 = 𝑢𝑠/𝜔, после преобразования, получим: 

∇𝑇𝑐𝑟𝑖𝑡 =
𝑝1𝜔

𝜌𝑚𝑐𝑝𝑢𝑠
,    (1.22) 

 Два изложенных выше режима работы термоакустического 

преобразователя, можно характеризовать с помощью отношения 

температурного градиента организованного в установке, к критическому 

градиенту, называемого нормализованным градиентом: 

Г =
∇𝑇𝑚

∇𝑇𝑐𝑟𝑖𝑡
,     (1.23) 

 Изменение температуры элементарного газового объема T1 при его 

смещении на расстояние x1 - величина крайне малая, но число этих микро 

объемов велико, как проиллюстрировано на рисунке 1.6. Их количество 

можно оценить как : 

𝑛 = 𝐿𝑠/𝑥1,     (1.24) 

 

Рисунок 1.6 - Механизм переноса энергии 

 

 Таким образом, величина 𝛥𝑇𝑚 ≫ 𝑇1 и в реальных устройствах может 

достигать десятков и более градусов. 
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 Критический градиент ∇𝑇𝑐𝑟𝑖𝑡 определяется разницей температур в двух 

противоположных точках цикла, которые занимает частица газа, когда ее 

скорость колебательного движения близка к нулю. Зная, что: 

𝑥1 = 𝜉/2 =
𝑝0
𝜌𝜔𝑎

sin𝑘𝑥𝑠 ≅
𝑝0
𝜌𝑎2

𝑥𝑠,    (1.25) 

 Подставим x1 и T1 в (1.21), получим: 

∇𝑇𝑐𝑟𝑖𝑡 =
𝑇1

𝑥1
= 𝛾

𝑝𝑚𝑇1

𝑝0𝑥𝑠
= (𝛾 − 1)

𝑇𝑚

𝑥𝑠
,   (1.26) 

 Данное выражение демонстрирует факт того, что максимальное 

значение ∇𝑇𝑐𝑟𝑖𝑡 вдоль стека достигается в зонах с максимальным давлением, 

вблизи торца резонатора. Например, на рисунке 1.3 стек расположен возле 

закрытого конца резонатора, но его положение может быть изменено 

зеркально, относительно середины резонатора. 

 Введем понятия необходимых нам масштабных величин: 

 1. Глубина вязкостной проницаемости - это расстояние по нормали от 

стенки до осциллирующего газа, на котором наличие стенки не оказывает 

влияния на характер движения потока. 

𝛿𝜐 = √2𝜈
𝜔

     (1.27) 

 2. Глубина термической проницаемости - это расстояние по нормали от 

стенки до осциллирующего газа, на котором наличие температурного 

градиента на стенке, не оказывает влияния на характер движения потока. 

𝛿𝑘 = √
2𝑘
𝜔𝜌𝑐𝑝

     (1.28) 

 Данные величины отвечают за количество газа, которое участвует 

непосредственно в совершении работы термоакустического цикла. Если 

расстояние междупластина стека будет слишком велико, то большая доля 

потока будет просто адиабатический перемещаться из стороны в сторону, не 

реализуя при этом процесс теплообмена. Если же расстояние между пластина 

стека слишком мало, то весь газа будет изотермический осциллировать 
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внутри каналов стека, таким образом не совершая процесс переноса тепла. 

Поэтому для термоакустических преобразователей использующих стек, 

расстояние между его пластинами должна быть порядка нескольких глубин 

термического и вязкостного проникновения, а отношение между этими 

величина характеризуется числом Прандтля, которое должно принимать 

следующее значение: 

Pr = (
𝛿𝜐

𝛿𝑘
)
2
≈ 1,    (1.29) 

 Выше изложенные принципу проиллюстрированы на рисунке 1.7. 

 1.4 Энергетическая оценка 

 Вернемся к веденным ранее понятиям тепла переданного 

элементарному объему и совершенной в результате этой передачи тепла 

работе (1.17 и 1.18). Используя 1.23, 1.22 и 1.16, перепишем выражения 1.17 

и 1.18 в следующем виде: 

𝛿𝑄 ≈ −
1

2
𝑉𝑝1(Г − 1),     (1.30) 

𝛿𝑊 ≈
1

4
(
𝑝𝑚
2 𝑉𝛽

𝜌𝑐𝑝
)
𝑚

(Г − 1),    (1.31) 

 

Рисунок 1.7 - Зависимость 𝛿𝑘 от частоты акустических колебаний и P-V диаграмма 

элементарных термодинамических циклов в различных зонах пограничного слоя 
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 Данные выражения показывают как отношение температурного 

градиента организованного в установке к критическому температурному 

градиенту влияет на тип термоакустического преобразователя, ранее это 

было описано с помощью (1.16), при этом затрагивался только характер 

изменения температуры. Очевидно, что знак разности (Г-1) показывает 

направление переноса теплоты - от газовой частицы к стенке или наоборот, и 

направление совершения работы - либо работа вырабатывается 

преобразователем, либо её необходимо совершать нам, для создания 

необходимого температурного градиента. Иными словами, с чем мы имеем 

дело, с холодильником или с двигателем. 

 Рассмотрим элемент стека длинной 𝐿𝑠, представленный на рисунке 1.8. 

Периметр этого элемента равен П, толщиной пластин пренебрегаем, 

получается что его ширина это П/2. Выше было показано, что в процессе 

участвует слой газа порядка величины 𝛿𝑘. Тогда эффективный объем газа, 

заключенный в этом слое, можно определить как 1/2П𝛿к𝑢1. 

 

Рисунок 1.8 - Элемент стека 
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 После интегрирования выражения (1.30) по ширине стенки, получим 

значение количества теплоты, передаваемой за счет термоакустического 

взаимодействия, через поверхность площадью1/2П𝛿к: 

𝑄̇ = − 1
2
П𝛿𝑘𝑝1𝑢1(Г−1),    (1.32) 

 Проанализируем составляющие данного выражения и оценим их 

влияние на величину теплового потока: 

- количество переносимого тепла пропорционально 𝑝1𝑢1. Следовательно, в 

узловых сечениях стоячей акустической волны как для скорости, так и для 

давления тепловой поток равен нулю; 

- максимальные значения 𝑝1𝑢1, а значит и 𝑄̇, достигаются вблизи точек с 

координатой x=1/4L и x=3/4L, то есть теплообменные поверхности должны 

располагаться вне узловых сечений, в местах с максимальным значением 

произведения 𝑝1𝑢1; 

- влияние поверхности характеризует сомножитель П𝛿𝑘, который показывает, 

что число пластин в стеке надо увеличивать, но так, чтобы зазор между 

пластинами был не меньше чем 2𝛿𝑘. 

 Объем газа, окружающего стек, который участвует в 

термоакустическом процесса, можно представить как: 

𝑉 = П𝛿𝑘𝐿𝑠,     (1.33) 

 Тогда работа получаемая (или совершаемая), в случае акустического 

переноса теплоты Q, будет равна: 

𝑊 =
1

4

П𝛿𝑘𝐿𝑠𝑝1
2𝛽2𝑇𝑚

𝜌𝑚𝑐𝑝
(Г − 1),    (1.34) 

 Учитывая, что акустическая волна имеет циклическую частоту 𝜔 =

2𝜋𝑓, то за один цикл будет затрачено количество теплоты𝑄̇для получения 

работы: 

𝑊̇ = 1
4
𝜔

П𝛿𝑘𝐿𝑠𝑝1
2𝛽

2
𝑇𝑚

𝜌𝑚𝑐𝑝
(Г−1),    (1.35) 
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 Предположим, что термоакустическая система замкнутая, энергообмен 

ограничивается только количеством теплоты (1.32) необходимым для 

совершения работы (1.35). Так же исходя из условия наличия короткого 

стека, количество теплоты не зависит от координаты x. Таким образом, кпд 

термоакустического двигателя находится следующим образом: 

𝜂 =
𝑊̇

𝑄̇
=

𝐿𝑠𝛽𝜔𝑝1

𝜌𝑚𝑐𝑝𝑢1
;     (1.36) 

 1.5 Резонатор Гельмгольца 

 Резонатор Гельмгольца - устройство состоящее из сосуда, снабженного 

горлышком - узким отростком, через которое сосуд сообщается с 

окружающей средой. При перемещении среды, заполняющей горлышко, в 

одну сторону и в другую сторону среда испытывает сжатия и разрежения, и 

давление в ней изменяется. На открытом же конце горлышка давление все 

время остается неизменным (атмосферным - для резонатора Гельмгольца в 

воздухе). Разность давлений на концах горлышка ускоряет массу среды 

внутри него. Ввиду узости горлышка скорость движения среды в нем велика 

по сравнению со скоростью среды внутри сосуда, так что кинетическая 

энергия сосредоточена в горлышке, несмотря на то, что фактическая масса 

среды в горлышке много меньше массы среды в сосуде. Упругая же энергия 

окажется сосредоточенной в среде внутри сосуда.  

 Таким образом, кинетическая и потенциальная энергия локализуются в 

разных телах: в среде в горлышке и в среде в сосуде. Значит резонатор 

Гельмгольца можно считать осциллятором с сосредоточенным параметрами. 

 Рассчитаем собственную частоту такого резонатора. Если длина 

горлышка много больше его поперечного сечения, то среда в нем движется 

как целое , и можно принять за обобщенную координату смещение 𝜉частиц в 

горлышке наружу. Обобщенной массой будет масса среды, заполняющая 

горлышко: 

𝑚 = 𝑆𝐿𝜌,     (1.37) 
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где 𝑆 - площадь сечения горлышка, L - его длина, 𝜌 - плотность среды. 

Степень сжатия среды в сосуде, соответствующая смещению 𝜉: 

𝜀 =
𝑆𝜉

𝑉
,     (1.38) 

где V - объем сосуда. Значит давление, возникающее в сосуде, равно: 

𝑝 = −
𝑆𝜉

𝛽𝑉
,     (1.39) 

где 𝛽 =
1

𝜌𝑎2
 - сжимаемость, характеризующая способность среды сжиматься 

под воздействием давления. Таким образом, обобщенная сила, действующая 

на обобщенную масса, равна: 

𝐹 = 𝑝𝑆 = −
𝑆2𝜉

𝛽𝑉
,     (1.40) 

откуда находим обобщенный коэффициент упругости осциллятора в виде: 

ℵ = −
𝐹

𝑚
=

𝑆2

𝛽𝑉
,     (1.41) 

 Используя выражение определяющее сжимаемость и формулу для 

нахождения частоты гармонического осциллятора, получаем искомую 

резонансную частота колебаний: 

𝑓 =
𝑎

2𝜋
√

𝑆

𝐿∙𝑉
,     (1.42) 

 С помощью данного выражения находится частота возбуждаемых в 

резонаторе акустических колебаний. 

 

2 ЭКСПЕРИМЕНТАЛЬНАЯ УСТАНОВКА 

 2.1Описание установки 

Лабораторная установка приведена на рисунке2.1, она включает в себя: 

измеритель-регулятор двухканальный ОВЕН 2ТРМ1, блок питания, 

стеклянную плоскодонную колбу (резонатор Гельмгольца), регенератор, 
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микрофон, штатив. На рисунке 2.2 представлена электрическая схема данной 

установки. Геометрия колбы представлена на рисунке 2.3. 

 Для определения температур на концах регенератора используется 

измеритель-регулятор двухканальный ОВЕН 2ТРМ1, представленный на 

рисунке 2.4. 

 Кнопка  предназначена для входа в режим программирование, а 

также для записи новых установленных значений в энергонезависимую 

память прибора. 

 Кнопки и предназначены для смены канала (𝑇1, 𝑇2 или ΔТ), 

выводимого на индикацию. 

 

 

 

Рисунок 2.1–лабораторная установка 

1–Индикатор питания, 2– Измеритель регулятор 2ТРМ1, 3–Реостат, 4–Нагреватель, 

5–Микрофон, 6–Колба, 7–Регенератор, 8–Тонкая настройка высоты штатива, 9–Грубая 

настройка высоты штатива, 10–Штатив. 
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Рисунок 2.2-электрическая схема лабораторной установки: 

М -Микрофон, Rh –Нагреватель, ВК–Выключатель питания, 2ТРМ1-Регулятор 

измеритель, Б.П–Регулируемый блок питания, Rp–Реостат, Л1–Светодиодный 

индикатор,Т1,Т2– Хромель-капелевые термопары 

 

 

Рисунок 2.3 - Геометрия колбы ( резонатора Гельмгольца) 
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Рисунок 2.4– измеритель-регулятор 2ТРМ1 

 

 2.2 Описание программы Sound Card Oscilloscope 

Осциллограф– прибор, предназначенный для исследования, 

наблюдения, измерения амплитудных и временных интервалов. 

Программа включает в себя: 

1– двухканальный осциллограф с частотой пропускания (зависит от 

звуковой карты) не менее чем от 20 до 20000 Гц; 

2– двухканальный генератор сигналов с аналогичной генерируемой 

частотой; 

3– анализатор спектра; 

4–возможность записи звукового сигнала для его последующего 

изучения; 

 На рисунке 2.5 представлено рабочее окно программы, где: 

 1 – Amplitude - регулировка чувствительности канала вертикального 

отклонения; 

 2 – Sync– позволяет (установив или сняв галочку) производить 

раздельную, или одновременную регулировку двух каналов по амплитуде 

сигналов; 

 3, 4 – позволяет разнести сигналы по высоте экрана для их 

индивидуального наблюдения; 
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Рисунок2.5– окнопрограммы SoundCard Oscilloscope 

 

 5 – установка времени развертки; 

 6– запуск/остановка работы осциллографа. При остановке на экране 

сохраняется текущее состояние сигналов, а также появляется копка Save (16) 

позволяющая сохранить текущее состояние на компьютере в виде 3-х файлов 

(текстовые данные исследуемого сигнала, черно-белое изображение и 

цветное изображение картинки с экрана осциллографа в момент остановки) 

 7 – Trigger – программное устройство, которое задерживает запуск 

развертки до тех пор, пока не будут выполнены некоторые условия и служит 

для получения стабильного изображения на экране осциллографа. Имеется 4 

режима: 

а)– включение/выключение. При выключенном триггере, изображение на 

экране будет выглядеть “бегущим” или даже “размазанным”; 

б)– автоматический режим. Программа сама выбирает режим (нормальный 

или одиночный); 
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в)– нормальный режим. В этом режиме осуществляется непрерывная 

развертка исследуемого сигнала; 

г)– одиночный режим. В этом режиме осуществляется одноразовая развертка 

сигнала ( с промежутком времени, установленным регулятором Time). 

 8 – выбор активного канала 

 9 – Edge – тип запуска сигнала: 

а)- rising – по фронту исследуемого сигнала; 

б)– falling – по спаду исследуемого сигнала; 

 10 – AutoSet – автоматическая установка времени развертки, 

чувствительности канала вертикального отклонения Amplitude, а также 

изображение выгоняется в центр экрана; 

 11 -ChannelMode – определяет, как будут выводится сигналы на экран 

осциллографа: 

single – раздельный вывод двух сигналов на экран; 

СН1 + СН2 – вывод суммы двух сигналов; 

СН1 – СН2 – вывод разницы двух сигналов; 

СН1 * СН2 – вывод произведения двух сигналов; 

 12 и 13 – выбор отображения на экране каналов (или любой из двух, 

или два сразу, рядом изображается величина Amplitude); 

 14 – вывод осциллограммы канала 1; 

 15 – вывод осциллограммы канала 2; 

 17 – шкала времени (у нас регулятор Time стоит в положении 10 

миллисекунд, поэтому шкала отображается от 0 до 10 миллисекунд); 

 18 – Status – показывает текущее состояние триггера а также позволяет 

выводить на экран следующие данные: 

HZandVolts – вывод на экран текущей частоты напряжения исследуемого 

сигнала 
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cursor – включение вертикальных и горизонтальных курсоров для измерения 

параметров исследуемого сигнала; 

Log to Fille – посекундная запись параметров исследуемого сигнала. 

 

3 ПОРЯДОК ПРОВЕДЕНИЯ ЛАБОРАТОРНОЙ РАБОТЫ 

1) С помощью грубой настройки высоты штатива переместить стэк в 

положение, как показано на рисунке 3.1а. 

2) Перевести регулятор тонкой настройки высоты штатива, так чтобы 

регулировочная метка располагалась по середине открытой части 

регулировочного колеса. (см. рис. 3.1б). 

3) Подключить кабель питания к сети 220V. 

 

а)                                                               б) 

Рисунок 3.1 - Начальное положение регулируемых элементов: 

а) стэк; б) тонкая регулировка штатива 

 

4) Подключить кабель Jack 3,5mm в разъем для микрофона к ноутбуку с 

установленным программным обеспечением, описанным в разделе 2.2 и 

запустить его. 
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5)Обеспечить подачу воды для охлаждения стэка. Для этого необходимо 

повернуть кран подачи воды, после чего обязательно проверить наличие 

утечек. 

6) С помощью кнопок  и перевести измеритель-регулятор в режим 

индикации температуры горячего конца стэка (T1). 

7) Запустить установку переведя переключатель со стороны кабеля питания 

из положение 0 в положение 1. 

8) В момент, когда установка прогреется и на стенках стэка выстроится 

необходимый градиент температур, появится характерный звук, после чего 

необходимо записать значениетемпературы горячего теплообменника, 

частоты выдаваемого звукового сигнала и амплитуду сигнала. 

9) Выключить установку и дать ей остыть до полного выравнивания 

температур на концах стэка.Это осуществляется переводом измерителя-

регулятора в режим индикации температурной разницы между горячей и 

холодной сторонами стэка ΔT. 

10). Произвести 10 оборотов регулятора тонкой настройки по часовой 

стрелке. После чего стэк должен располагаться выше на расстояние равное 

своей длине(в соответствии с рисунком 3.2.). 

 

Рисунок 3.2 - Расположение стэка во втором опыте 
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11) Повторить действия в соответствии с пунктами 6-11. 

12) Занести все результаты в бланк регистрации экспериментальных данных 

(таблица 1). 

 

Таблица 1 - Бланк регистрации экспериментальных данных 

№ fэксп, Гц T2, K Pэксп, Дб(Па) 

1    

2    

3    

 

4 ОБРАБОТКА ЭКСПЕРИМЕНТАЛЬНЫХ ДАННЫХ 

 1) Рассчитать значение собственной частоты резонатора по формуле 

(1.42). Геометрию резонатора взять из рисунка 2.3. Произвести сравнение с 

экспериментальным значением, объяснить расхождения. 

 2) Построить зависимости Рэксп(x), T2(x)и fэксп(х). При этом за х 

принимается положение стэка, для начального положения 

соответственноx=0. Объяснить физический смысл полученной зависимости. 

 3) Необходимые для дальнейшего расчета теплофизические 

характеристики воздуха представлены в таблице 2. Амплитуду давления 

принимаем 40 Па, а амплитуду колебательной скорости 0,1 м/с, за рабочую 

частоту принимаем экспериментальное значение частоты. 

Таблица 2 - Теплофизические свойства воздуха 

β, [-] cp, [
Дж

кг∙К
] ρm, [кг/м3] к, [

Вт

м∙К
] 

0,3665*10-2 1005 1,19 0,03 
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 4) Используя формулы (1.11), (1.21), (1.22) рассчитать 

нормализованный градиент температуры. 

 5) Используя (1.28)и схему представленную на рисунке 4.1, рассчитать 

объем газа участвующего в процессе в пределах одного канала. 

 

Рисунок 4.1 - Схема расчета объема газа участвующего в цикле 

 

 6) Исходя из того, что для заданного стэка 𝜀 =
𝐴пор

𝐴полная
= 0,64, 

подсчитать общее число каналов и общий объем газа участвующего в 

процессе. 

 7) По формулам (1.32), (1.34) и (1.36) рассчитать количество теплоты 

участвующей в термоакустическом цикле, получаемую работу и кпд 

установки. 

 8) Результаты свести в бланк регистрации расчетных данных.(см. 

таблица 3) 

Таблица 3 - Бланк регистрации расчетных данных 

Г Vобщ, м3 Q, Дж W, Дж η 

     

 

5 СОДЕРЖАНИЕ ОТЧЕТА 

 1) Принципиальная схема установки. 

 2) Заполненный бланк регистрации экспериментальных данных для 

трех положений стэка. 



29 
 

 3) Расчет, сравнение и объяснение расхождения собственной частоты с 

экспериментальной рабочей. 

 4) Графики полученных зависимостей. 

 5) Заполненный бланк регистрации расчетных данных. 

 5) Выводы. 

 

6 ЧИСЛЕННОЕ МОДЕЛИРОВАНИЕ ТЕРМОАКУСТИЧЕСКОГО 

ЭФФЕКТА 

 6.1 Введение 

 Основная задача данной лабораторной работы провести численное 

моделирование термоакустического эффекта с помощью методов 

вычислительной гидрогазодинамики (CFDметода). 

 Моделирование включается в себя следующие этапы: 

- принятие определенных допущения для упрощения расчета; 

- построение расчетной модели в CADсистеме; 

- получение сеточной модели из расчетной; 

- задание граничных условий на основе принятых допущений; 

- расчет полученной конечно-элементной модели; 

- визуализация полученных результатов и получение необходимых значений 

рабочих параметров. 

 Для данной модели термоакустического преобразователя были 

приняты следующие допущения: 

- рассматривается двухмерная осесимметричная модель; 

- рабочее тело воздух как идеальный газ; 

- давление на входе в резонатор 1 атм; 

- стэк моделируется как система параллельных пластин; 
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- работа теплообменников моделируется как температурный градиент 

наложенный на стенки стэка в качестве граничного условия; 

 6.2 Построение расчетной сеточной модели 

 Построение осуществляется в программе CFD-GEOM. Ее запуск 

осуществляется нажатием на соответствующий ярлык на рабочем столе или 

из меню "Пуск" ОС "Windows": 

Пуск → Все программы → ESI Group → CFD-GEOM 

 В результате этого действия появится окно, изображенное на рисунке 

6.1.  

 

Рисунок 6.1 - Стартовое окно CFD-GEOM 

 

 Нажимаем New File, после чего появляется окно New Model, где в поле 

Model Name вводится название модели, в поле Directoryуказывается рабочая 

папка, куда будут сохранятся все файлы проекта, в поле Unitsвыбираются 

единицы измерения, в которых будет строится расчетная модель, в данном 

случае выбираем Millimeters. После этого следует начать OK. Это приведет к 

появлению окна программы CFD-GEOM. Оно показано на рисунке 6.2. 
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Рисунок 6.2 - Рабочее окно программы CFD-GEOM 

 

 Расчетная модель, с учетом указанных выше допущений представлена на рисунке 

6.3.  

 

Рисунок 6.3 - Расчетная модель 

 

 Построение модели начинается с построения основных точек 

координаты которых указаны в таблице 6.1. В результате рабочая область 

должна выглядеть как на рисунке 6.4. 
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 Таблица 4 - Координаты начальных точек для построения 

№ точки X Y 

1 0 0 

2 0 18 

3 50 0 

4 50 18 

5 70 18 

6 70 0 

7 126 0 

8 170 0 

9 170 18 

 

 Построение точек производится с помощью команды Point Creation 

Options→Coordinates/Screen-Pick которая находится в рабочих инструментах 

меню Geometry. В поля X, Yвбиваются координаты необходимой точки, 

после чего нажатием кнопки Preview можно осуществить предварительный 

просмотр, а кнопкой Apply подтвердить положение точки. В результате на 

рабочей области экрана появятся точки представленные на рисунке 6.4. 
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Рисунок 6.4 - Построение начальных точек 

 

 Далее, с помощью команды Conic Creation → 2-Point Circle строится 

окружность, при этом первой выбирается точка 7 (клик левой кнопки мышки 

на точки, а затем на кнопку колеса), как середина окружности, затем точка 5, 

как радиус. Далее ставим точку с координатами (170; 50) и с помощью 

команды Line Creation → Create Line(s) соединяем ее линией с точкой 9. В 

результате рабочая область должна выглядеть как на рисунке 6.5.  

 Следующим шагом, необходимо отсечь лишнюю часть окружности. С 

помощью команды Point Creation Options → Curve/Curve Intersection 

определяем точку пересечения окружности и вспомогательной кривой (левой 

кнопкой мышки на окружности, а затем на прямую, после чего нажимаем 

колесико). Выбираем команду Geometry splitting/joining options → Split Curve 

at Point, далее левой кнопкой мыши на окружность, и подтверждаем выбор 

колесиком, после чего левой кнопкой мыши на получившуюся точку 

пересечения со вспомогательной прямой и точку 5 и еще раз колесико. 

Аналогичное проделываем со вспомогательной прямой, чтобы разбить ее на 

две части точкой пересечения с окружностью. После чего удаляем все 
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лишнее, соединяя точки 9 и 8 линией, так чтобы рабочая область выглядела 

как на рисунке 6.6. 

 

Рисунок 6.5 - Построение вспомогательной геометрии 

 

 

Рисунок 6.6 - Построение вспомогательной геометрии 

 

 Ставим точку с координатами (70;40) и соединяем ее с другой точкой 

прямой, как показано на рисунке 6.7. 
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Рисунок 6.7 - Построение вспомогательной геометрии 

 

 После чего разбиваем дугу получившейся точкой пересечения ее со 

вспомогательной прямой, как показано на рисунке 6.8. 

 

Рисунок 6.8 - Построение вспомогательной геометрии 

 

 Соединяем оставшиеся точки как показано на рисунке 6.9. 
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Рисунок 6.9 - Построение основной геометрии 

 

 Построение стэка начинается с построения 4 точек, координаты 

которых представлены в таблице 5. 

Таблица 5 - Координаты точек для построения стэка 

№ точки X Y 

1 50 0,1 

2 50 0,9 

3 70 0,1 

4 70 0,9 

 

 Полученные точки соединяются линиями, так чтобы получился 

прямоугольник, как показано на рисунке 6.10. 
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Рисунок 6.10 - Построение стэка 

 

 Для удобства создания сеточной модели, области течения между 

пластинами стэка, сразу разбиваются на сетку. Разбиение начинается с 

создания узловых точек на граничных линиях поверхности. Для этого 

переходим в меню Mesh, выбираем команду Edge options → Create/Edit Edge, 

указываем одну из боковых сторон прямоугольника и заполняем поля 

согласно рисунке 6.11, после чего жмем Apply или колесико мышки и 

выполняем аналогичную операцию для противоположной боковой стороны 

прямоугольника. 
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Рисунок 6.11 - Построение стэка 

 

 На следующем этапе разбиваются верхние и нижние стороны 

прямоугольника, без дополнительных распределений, число точек задается 

20, в результате картина должна выглядеть как на рисунке 6.12. 

 

Рисунок 6.12 - Построение стэка 

 



39 
 

 С помощью функции Structured Face Options → Face From Edges 

собирается плоская сеточная область, для этого выделяется и подтверждается 

(клик левой, затем колесико) каждая из сторон прямоугольника. Основное 

правило для построения структурированной сеточной области состоит в том, 

чтобы число точек на противоположных линиях должно быть одинаковых, 

иначе область не замкнется. В результате должна получится сеточная 

область, как показано на рисунке 6.13. 

 

Рисунок 6.13 - Построение стэка 

 

 Возвращаемся в меню Geometry и выбираем команду Transformor 

Duplicate/Transform Entities → Translate указываем получившуюся сеточную 

область, в меня Directionвыбираем y, отмечаем Duplicate, в поле Distance 

оставляем 1, в поле Times указываем 17 - число копий областей течения стэка 

заполняющих горло резонатора. В результате область построения должна 

выглядеть как показано на рисунке 6.14. 
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Рисунок 6.14 - Построение стэка 

  

 На следующем этапе работы необходимо соединить каждый 

прямоугольник линиями, а соединяющие их линии разбить на две точки 

каждую, методом который был использован для разбиения сторон 

прямоугольника, как показано на рисунке 6.15. 

 

Рисунок 6.15 - Построение стэка 
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 После чего все оставшиеся линии разбиваются на точки. Количество 

точек для каждой линии указано на рисунке 6.16. 

 

Рисунок 6.16 - Число точек разбиения оставшихся линий 

 

 Следующим шагом все получившиеся линии объединяются в 

отдельные сеточные области. Важно понимать, что сеточная область 

обязательно должна состоять из 4 сторон, таким образом чтобы число 

разбиений на противоположных сторонах было одинаковым, и сторона 

может состоять и отдельных линий. Конечная сеточная модель показана на 

рисунке 6.17. 

 

Рисунок 6.17 - Сеточная модель 
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 Далее создаются отдельные расчетные 2-Dблоки с помощью команды 

Structured and Semi-Structured Domain Options → Create 2-D Block в меню 

Mesh. Для этого необходимо кликнуть левой кнопкой мышки, а затем 

кнопкой колеса мыши, на каждую сеточную область, так чтобы в результате 

она перекрасилась из серого цвета в фиолетовый, как показано на рисунке 

6.18. 

 

Рисунок 6.18 - Конечная расчетная сеточная модель 

 

 В меню BC/VC выбираем Boundary conditions, после задаются 

граничные условия Inlet и Symmerty, как указано на рисунках 6.19 и 6.20 

соответственно. 

 На этом этапе построение расчетной модели завершается. Для 

дальнейшей работы с моделью следует сохранить сначала файл в формате 

GGD (файл сеточной области), а затем в форматеDTF (файл для работы в 

процессоре CFD-ACE+). Это осуществляется с помощью выполнения 

следующих действий,File→Save as, за счет изменения формата в поле File 

Type. 
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Рисунок 6.19 - Задание граничного условия Inlet 

 

 

Рисунок 6.20 - Задание граничного условия Symmetry 

 

 6.3 Расчет рабочих процессов термоакустического преобразователя в 

CFD-ACE 
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 Настройка расчета выполняется в программе CFD-ACE. Ее запуск 

осуществляется нажатием на соответствующий ярлык на рабочем столе 

компьютера или из меню "Пуск" ОС "Windows": 

Пуск → Все программы → ESI Group → CFD-ACE 

 В результате этого действия появится окно, изображенное на рисунке 

6.21. Заходим в File → Open и находим папку, в которой сохранен DTF файл, 

после чего открываем его. 

 

Рисунок 6.21 - Рабочее окно CFD-ACE 

 

 Настройка задачи начинается с выбора расчетных модулей в меню 

Problem Type, которые определяют решаемую систему уравнений. В данном 

случае ставится галочка в окне Modules напротив опции Flow,которая 

включает в решаемые задачи уравнение неразрывности и уравнение 

количества движения, и так же включается опция Heat Transfer(Heat), для 

моделирования теплового процесса. 

 Далее переходим во вкладку Model Options. В поле Polar (Axisymmetric 

about X - axis) ставим Axisymmetric, обозначая таким образом то, что наша 

задача является осесимметричной. В поле Transient Conditions активируется 
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опцияTransient, для настройки нестационарности процесса. В появившемся 

окне настройки времени расчета задается число шагов No. of Steps - 5000, 

величина шага времени Time Step- 2E-05(экспоненциальная запись числа с 

порядком). В поле Time Accuracy выбирается полу неявная разностная схема 

Crank-Nicolsonс Blending Factor 0.7, которая используется для 

быстропротекающих процессов, в том числе и для расчета акустической 

волны. В результате меню Model Options должно выглядеть аналогично 

рисунку 6.22. 

 

Рисунок 6.22 - Настройка расчетной модели 

 

 Во вкладе Flow меняем среднее давление в расчетной области Reference 

Pressure на 101325 Па. 

 Далее запускается меню настройки объемных условий Volume 

Conditions(VC). Затем зажимается клавиша Shift, и выделяется 

прямоугольником вся расчетная область. В поле Material в Property Sources 

выбирается Import From Database и в Gas Material Name выбирается Air 

(даже если он уже выбран, то все равно указывается еще раз, чтобы окно 

выглядело аналогично рисунку 6.23). Таким образом мы задано рабочее тело 
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(воздух), параметры которого меняются согласно уравнению состояния 

идеального газа. 

 

Рисунок 6.23 - Настройка расчетной модели 

 

 Далее выполняются настройки во вкладке Boundary Conditions (BC)и 

выбирается указанная ранее как Inlet граница. В поле Sub Typeуказываем 

Fixed Pressure и нажимаем Apply. 

 При нажатой клавишеShiftвыделяются все составляющие стэк прямые 

(параллельные оси Х), а затем переходим во вкладку Heat, в поле Sub Type 

выбираем Isothermal, а в поле Temperature меняем на Parametric, как 

показано на рисунке 6.24. Теперь необходимо задать уравнение 

температурного градиента на стенках стэка, для чего выполняем следующие 

действия:  

 - нажимаем Define...; 

 - в появившемся окне в поле Expression Table жмем Append; 

 - в ячейке Names вводится название уравнения "GRADIENT"; 

 - в ячейке Values вводится уравнение градиента 

"500+200*SIN(50*PI*(X-0.02))" 
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 - нажимаетсяOK, и в поле Expressionвыбирается заданное уравнение; 

 - нажимаетсяApply. 

 

 

Рисунок 6.24 - Настройка расчетной модели 

 

 Переходим во вкладку Solver Control (SC) и задаем максимальное число 

итераций для каждого временного шага расчета Max. Iterations 60, как 

показано на рисунке 6.25. 

 

Рисунок 6.25 - Настройка расчетной модели 
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 Во вкладке Solver Control (SC) переходим в Relax и выставляем все 

параметры релаксации на условия максимальной стабильности расчета, как 

показано на рисунке 6.26. 

 

Рисунок 6.26 - Настройка расчетной модели 

 

 Переходим в меню Output(Out) для настройки выходных данных 

расчета. В "General"в поле Every ставим 10. Это значит, что программа будет 

записывать выходной файл с результатами через каждые 10 временных 

шагов. Во вкладке Graphic дополнительно ставится галочка напротив Total 

Pressure, для того чтобы получать на выходе также и значение необходимого 

нам полного давления (в соответствии с рисунком 6.27). 

 Затем осуществляется переход в меню Run and Monitor(Run), где 

выбирается Submit to Solver( начать расчет), после чего появляется окно в 

котором предлагается записывать расчетные файл в папку, в которой 

находится проект или создать отдельную папку. Выбираем создать 

отдельную папку Submit Job Under a Different Name. В папке проекта создаем 

новую папку под названием Solution и нажимаем ОК. 



49 
 

 

Рисунок 6.27 - Настройка расчетной модели 

 

 6.4 Обработка полученных результатов 

 Обработка полученных результатов осуществляется в программе CFD-

VIEW. Ее запуск осуществляется нажатием на соответствующий ярлык на 

рабочем столе или из меню "Пуск", ОС "Windows": 

Пуск → Все программы → ESI Group → CFD-VIEW 

 После чего появляется начальное окно программы изображенное на 

рисунке 6.28. 

 

Рисунок 6.28 - Обработка полученных результатов 
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 Нажимаем Import File и находим в папке проекта файл с названием 

"Название проекта"0000000.DTF, выбираем и нажимаем ОК. Далее заходим в 

File → Select Files For Animation и должен отобразиться путь к проекту. 

Затем выбираем в появившемся окне все файлы начиная с 0000000 до 

0005000, с помощью клавиши Shift и последующего нажатия кнопки ОК. 

 В меню выбора отображаемой поверхности нажимаем Select all 

surfaces. После чего в меню выбора отображаемой величины активируем 

опциюColored surfaces on, поверхность приобретет серый цвет. В поле Color 

можно выбрать любую интересующую нас величину (например 

зададимP_tot- Total Pressure). Дополнительно, в меню графических 

операторов активируется опция Legend (чтобы вывести на экран шкалу 

изменения давления). 

 Выведем на рабочее поле график изменения давления от времени в 

горле резонатора. Для этого необходимо выполнить следующие действия: 

 - в меню графических операторов выбрать Probe, в результате чего на 

поверхности появиться красный крестик, который необходимо переместить в 

область горла резонатора; 

 - в меню графических операторов нажимаем Point History; 

 - ставим галочку напротив опции Use Time Data from File и выбираем 

Plot в меню графических редакторов; 

 - в поле Plot Y-Axis выбираем P_tot и ставим галочку на Copy Plot Image 

into 3D Viewer. 

 Появившееся окно графика можно увеличивать и уменьшать по 

размеру и перемещать по рабочей области независимо от отображенной 

поверхности. Располагаем модель и график как показано на рисунке 6.29. 

После чего повторно нажимаем Select all surface, переходим во вкладку Color 

map в меню настройки визуализации результатов расчета выбираем Dynamic, 
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чтобы область отображаемых значений автоматический перестраивалась в 

зависимости от шага. 

 

Рисунок 6.29 - Обработка полученных результатов 

 

 Для записи анимации необходимо перейти во вкладку Animation в 

меню настройки визуализации результатов расчета и нажать кнопку 

Record(красный круг). В появившемся окне нажимаем Accept и ждем 

окончания записи. При этом не желательно заслонять рабочую плоскость 

какими-либо окнами, так как в запись идут все действия происходящие на 

экране. 

 В папке с расчетом появится файл animation.gif, который можно 

открыть и просмотреть с помощью любого проигрывателя воспроизводящего 

gif анимации. 

 В меню выбора отображаемых поверхностей выбирается 

Plot(построенный график) и производится быстрое Фурье преобразование 

записанного сигнала (FFT)для определения рабочей частоты резонатора. Для 

этого в поле Digital Signal Processor (DSP) нажимаем "+" после чего Create. 

На графике будет представлен частотный спектр записанного сигнала, где 

наибольшему значению амплитуды сигнала соответствует рабочая частоты 
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резонатора, как показано на рисунке 6.30. Полученный график можно 

скрыть, отключив опцию Copy Plot Image into 3D Viewer. 

 

Рисунок 6.30 - Частотный спектр записанного сигнала 

 

 Далее выбирается верхняя или нижняя граница одного из каналов стэка 

и в меню графических операторов нажимается опция Plot.В появившемся  

окне настройки графика, по оси X откладывается координатаX, а по оси Y 

выбирается T (температура), после чего данной графическое поле выводится 

на рабочую область экрана (для этого активируется опция Copy Plot Image 

into 3D Viewer). Полученный график демонстрирует форму заданного 

температурного градиента на стенках стэка (см. рисунок 6.31). 

   



53 
 

 

Рисунок 6.31 - Температурный градиент на стенках стэка 

 

 На следующем этапе данной работы проведем доказательство того что 

данный преобразователь является термоакустическим двигателем на стоячей 

волне. Для этого необходимо: 

 - в меню графических операторов выбрать Probe, в результате чего на 

поверхности появиться красный крестик, который необходимо переместить в 

область горла резонатора; 

 - в меню графических операторов активируется опцияPoint History; 

 - активируетсяUse Time Data from File и выбирается опция Plot в меню 

графических редакторов; 

 - по оси X откладывается Time, по оси Y откладываются P_tot и U (при 

зажатой клавише LCtrl выбираются по очереди P_tot и U ); 
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 - отключается опция Multiple Curves Share Y-Axis Scale (чтобы каждая 

величина имела свою размерную шкалу); 

 - активируется опция Copy Plot Image into 3D Viewer; 

 - во вкладке Animation в меню настройки визуализации, в поле Current 

Frame вводится количество кадров, равное 250; 

 - производится обнуление информации на выведенных графиках. Для 

этого в меню выбора отображаемой поверхности выбирается опция Point 

History и в появившемся окне нажимается Reset History, графики 

находящиеся на рабочей области экрана, должны обнулиться; 

 - во вкладке Animation нажимается Play. 

 - после того как на графике отрисуется один полный период рабочего 

процесса моделируемой установки, нажимается Stop; 

 В результате получается график, аналогичный изображенному на 

рисунке 6.32. Из графика видно, что разность фаз между изменением 

давления и скорости внутри установки составляет около 90 градусов, что 

соответствует термоакустическому преобразователю на стоячей волне. 

 

Рисунок 6.32 - Разность фаз между скоростью и давлением 
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